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Preface
What a difference a few years make! In the time since the first edition of this book was con-
ceived, SketchUp and everyone who makes it left Google and joined Trimble, a company until 
then mostly known for GPS technology for construction (and other related fields), and Tekla, 
a steel-design software from Finland. In the meantime, Trimble has integrated SketchUp into 
many of its work areas and is actively pursuing a broadening of its software offerings. Case 
in point being the acquisition of Gehry Technologies and its software products.

All of this came along with significant performance increases for SketchUp and the inte-
gration of substantial BIM-elements into the software. SketchUp also received an online 
Extension Warehouse as an easy means for users to find and acquire extensions that add 
capabilities to SketchUp. 3D Warehouse, an online repository for SketchUp models, has also 
received a major upgrade, and it now features a WebGL online 3D file viewer.

In the same timeframe, the maker-movement has gone into overdrive, leading to many 
“maker spaces” where people combine advanced yet cost-efficient fabrication techniques 
with electronics and programming to create fully functional prototypes of technology-based 
objects in a much shorter time and at a lower cost than was heretofore possible. 3D model-
ing has become an essential part of this process during digital prototyping and prefabrica-
tion steps (e.g., for 3D printing).

This second edition of Architectural Design with SketchUp pays heed to these developments. 
SketchUp’s new capabilities have been highlighted mainly in chapters 2, 3, and 4. Where 
applicable, the updated Ruby scripting environment is reflected in chapter 7. While the title 
of this book retains its architecture focus, much of the content is now also applicable to 
many of the construction uses that come along with Trimble’s application of this software.

An entirely new chapter 6, on making with SketchUp, has also been introduced. It covers 
the most common fabrication techniques in use with SketchUp (3D printing, laser cutting, 
CNC routing, and fabrication planning) to give the reader step-by-step instructions on using 
these in his or her work.

This edition, in other words, incorporates the many “faces” of SketchUp to an even greater 
degree than the previous edition. It provides an essential desk reference for any SketchUp 
user and a thorough and well-organized learning sourcebook for those that seek to enhance 
their knowledge of this software.
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Chapter 1
Introduction 

During my years of teaching SketchUp, as well as other Computer-
Aided Design (CAD) and Building Information Modeling (BIM) 
software, I have seen many very proficient users of this software. 
Students and professionals take easily to SketchUp, and, before 
long, most of them produce very detailed building models 
and professional-grade renderings. But I have also found that 
too many people don’t go beyond the basics and believe that 
some of the advanced modeling (or good-quality photoreal-
istic rendering) needs to be done using other software. Very 
often, they painstakingly pick up that other software only to 
find that it is too complex, which likewise leaves them unable 
to do what they wanted.

Sometimes even advanced users of SketchUp master one aspect of the software (pho-
torealistic rendering, for example) but are completely unaware of the power that SketchUp 
holds in other areas—Dynamic Components and Ruby scripting are good examples. As you 
will find out in this book, SketchUp is a very powerful design and 3D modeling tool. Some 
of its core features—for example, its extendibility with extensions (these are sometimes also 
called plugins)—make it flexible enough to be useful for a variety of disciplines. The large 
number of high-quality extensions that are currently available for SketchUp bears powerful 
witness to this.

This book attempts to help the basic to intermediate user make the leap from simply 
creating “something” in SketchUp to using it as a powerful design tool. It also contains 
some more advanced topics (such as photorealistic rendering, Dynamic Components, BIM, 
and Ruby scripting) and provides a clear learning path that takes the reader through easy-
to-follow examples to a thorough understanding of the core topics. Figure 1.1 shows an 
example of how you could use Ruby scripting to create geometry, then render the scene using 
photorealistic rendering software, and finally “dress up” the image as a watercolor painting.

About This Book
Each chapter in this book presents a different SketchUp use in sufficient detail to get you 
started and working quickly. Interspersed with the text are many step-by-step examples, tips, 
and in-depth articles. At the end of each chapter, you will also find a collection of activities 
that you can undertake to try out new skills that you just learned.
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Chapter 2, which follows this introductory chapter, brings every reader up to speed. Its 
purpose as a “SketchUp Refresher” is to review most of the basic modeling techniques and 
teach good practices for 3D modeling and software use. While many readers will already 
have some knowledge of SketchUp through introductory books or video tutorials, this chapter 
encompasses enough variety to be useful for everyone, independent of their skill level. In addition 
to modeling, this chapter covers materials, program setup and user interface, custom templates, 
geo-based modeling, and plan-based modeling. 

Chapter 3 uses SketchUp not only as a modeling tool but also as a tool to inform your 
designs. In this chapter, you will learn more ways to efficiently work with SketchUp and 
add data and design intelligence to your models. Examples of this are creating hierarchical, 
component-based models (e.g., for virtual construction), using Dynamic Components and 
parametric design, and working with SketchUp’s Classifier system. This chapter also lays out 
how SketchUp can fit into a BIM-based architectural design process.

Chapter 4 leads you into the wide field of SketchUp extensions and their uses. After an 
introductory section on finding and installing extensions, many individual extensions are dis-
cussed. Those small software add-ons to SketchUp provide tools for general modeling, such as 
drawing splines and lofting curves; tools for architectural design, such as stair making and wood 
framing; and tools for digital fabrication that will help you prepare your model for 2D and 3D 
digital printing and assembly. (See Figure 1.2 for an example of a fabricated SketchUp model.) 
Furthermore, there are extensions for data integration that can import or export data such as 
Laser Imaging, Detection and Ranging (LIDAR) laser-scan points; extensions for animation and 

Figure 1.1:  Digital watercolor of a rendering of script-generated panels
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presentation that add object animation or serve as helpers for creating animations and walk-
throughs using SketchUp; and, finally, extensions for analysis, which provide analytical tools—
mainly from the field of building energy analysis and green building.

Chapter 5 introduces photorealistic rendering and covers all aspects of rendering in detail 
(see Figure 1.3 and Figure 1.4). This chapter was written to be as independent of your actual 
choice of rendering software as possible, thereby providing a useful resource no matter which 
software you end up getting. As part of this chapter, you will learn about modeling for ren-
dering, lighting, sky environment, materials, and objects, as well as how to edit and modify 
renderings for final presentation using image-editing software.

Figure 1.2:  Infrared photography house model made in SketchUp and physically built using extensions



Architectural Design with SketchUp

4

Figure 1.3:  A night rendering of the cover scene

Figure 1.4:  A grassy hill modeled and rendered in SketchUp

Chapter 6 lays out how SketchUp can be used for digital fabrication. While SketchUp 
has always been used to fabricate buildings, this was typically accomplished with a manual 
process (employing workers) and analog intermediaries (construction documents). Digital 
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fabrication (as employed in cut preparation, 3D printing, laser cutting, CNC routing, etc.) 
uses the full precision that the computer provides from concept to final product. This 
approach offers many new and exciting possibilities (see Figure 1.5 for an example), and 
this chapter provides you with step-by-step instructions on how to use these techniques 
with SketchUp.

Figure 1.5:  SketchUp’s CNC-cut WikiHouse pavilion for the 2013 New York Maker Faire  (Used by permission of 
Trimble Navigation Ltd.)

The final chapter in this book (Chapter 7) introduces you to the exciting field of computa-
tional geometry in SketchUp. This chapter presents Ruby script examples that create undulat-
ing brick walls, solar-responsive facades, attractor-based colorful building designs, and other 
fun ways to create geometry in SketchUp without excessive use of the mouse (see Figure 1.1 
or the paneling on the title cover for examples). Most of the script examples accomplish their 
tasks in just a few lines of code, and all are good introductions to both the Ruby scripting 
language and the general field of computational geometry.

Chapter 7 can also serve as a “learn to code” curriculum for young or adult readers. It 
introduces basic programming concepts and applies them in a way that yields 3D models. 
It should be quite exciting for the learner that the results from this approach can even be 
3D printed and, therefore, turned into physical objects.

As you will see in the chapters that follow, this book is intended to serve as a textbook 
as well as a desk reference. It was written to convey the presented material in a thorough 
yet easy-to-follow manner. It also covers common tasks using a cookbook approach, which 
allows you to simply copy the procedure to get a satisfactory result or modify it according 
to your individual needs.
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In addition to reading this book, keep checking its companion website, which features 
news, tutorials, links, videos, and downloads related to this book. You can also interact there 
with the author and other SketchUp users and discuss any issues you may run into. Web links 
will be frequently updated there, and new ones added as new software is released.

This book’s companion sites can be found here:

www.sketchupfordesign.com—Author’s interactive companion site.

www.wiley.com/go/schreyer2e—Companion site for classroom use.

3D for All
Because SketchUp is not domain-specific, it has found a following with professionals and 
enthusiasts from many disciplines. This is why you will find SketchUp mentioned in discus-
sions not only by architects, landscape architects, urban planners, engineers, construction 

professionals, woodworkers, and timber framers but also by 
robot builders, artists, sculptors, model-plane builders, paper-
plane builders, mapmakers, historians, 3D game developers, and 
movie set designers (just to mention a few).

The techniques in this book are applicable to a variety of 
disciplines. Although many examples come from architecture 
or construction, some are from other disciplines (e.g., land-
scape design and interior design). Whatever your background 
is, feel free to take the examples that are presented here and 
adapt them to your discipline. (See Figure 1.6 for a nontra-
ditional use of SketchUp). The techniques you learn will be 
equally useful.

Taking this one step further, I can even say that I can’t think of anyone who should not 
be using SketchUp. Living in a three-dimensional world and dealing with three-dimensional 
objects, everyone has the need at some point to model and visualize virtually in three-
dimensional space.

Consider this hypothetical situation: You want to build a deck in your backyard and 
need to explain to the builder how it should look. Another example is a scientist who needs 
to explain a lab setup in a presentation. Far too often we resort to 2D representations of 
our thoughts (the classic floor plan, for example), which leaves too much unknown and 
unexplorable.

Admittedly, many people are not trained in hand-sketching in 3D, which often leads to 
poor visualizations of things that can actually be quite interesting when presented properly. 
That is where SketchUp shines. Its 3D modeling capabilities and its ease of use make it a 
simple yet very powerful tool for anyone to give shape to their thoughts.

http://www.sketchupfordesign.com
http://www.wiley.com/go/schreyer2e
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How Does SketchUp Fit into the Designer’s Toolbox?
As a professional or student, you likely already have assembled a sizable software “tool chest” 
by now. Depending on your discipline, this might include office software, CAD software, 
image-editing software, print layout software, analysis software (for energy or structural 
analysis, for example), coordination tools, and many others.

SketchUp fits into this collection very well. While the free SketchUp Make provides a 
complete 3D modeling tool set for the hobbyist, the commercial SketchUp Pro broadens this 
further by adding layout and documentation abilities and other professional-oriented tools, 
such as multiformat import/export and BIM capabilities.

Depending on your needs and knowledge of the software, you can use it as an early design 
tool—after all, as its name indicates, it was developed for 3D sketching. In that capacity, it 
shines by providing easy editing and immediate 3D visualization (see Figure 1.7)—something 
that can be very useful during quick design iterations.

You can also use it for the complete design process from initial stages to a finished 
product (whatever that may be—buildings, gadgets, etc.). For that case, it provides the 
capability to create precise, organized models that can contain any level of data. Those 
models can then be used as the basis for construction or production documents (with 
SketchUp Pro’s LayOut software) and/or be exported for digital-process-based fabrication, 
such as CNC routing.

Figure 1.6:  Rendered 3D QR-code model



Architectural Design with SketchUp

8

SketchUp also works well with other software. 3D models from SketchUp can often 
be opened directly in those programs, making data exchange easy. Even if that isn’t avail-
able, SketchUp’s built-in file exchange options allow you to export a 3D model in a variety 
of formats. As shown in Figure 1.8, built-in services and extensions exist that connect 
SketchUp to online collaboration platforms where you can share your models with only 
a few clicks.

Figure 1.7:  Architectural design visualization model  (Image used with permission of Leers Weinzapfel 
Associates)

Figure 1.8:  Trimble’s Connect platform for construction collaboration and file exchange  (Used by permission of 
Trimble Navigation Ltd.)
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If SketchUp is already part of your tool set, then the best use of your time will be to expand 
on the skills you have developed already and deepen your knowledge of this software. This 
book provides you many avenues to do so.

Windows or Mac, Pro or Make?
SketchUp comes in a variety of flavors: While SketchUp Pro is the core commercial product, 
Trimble maintains (and has expressed its ongoing commitment to) a free “Make” version. 
Both are multiplatform software, which means they are available for both Windows and Mac 
computers. In addition, SketchUp has viewers for computers (both platforms), and Apple and 
Android tablets and phones.

The free version, SketchUp Make, is geared toward hobbyists, makers, and private 3D 
modelers. While it comes with a significant subset of the 3D modeling functionality included 
in the Pro version, its license limits it to noncommercial uses, and it does not include the 
LayOut presentation software. It is, however, capable of COLLADA and KMZ import/export, 
which is useful for makers, and it allows for installation of (most) extensions, including render-
ing applications.

The commercial version, SketchUp Pro, adds a variety of professional-oriented features:

■■ LayOut software for drawing-preparation and presentations

■■ Style Builder software for creating custom sketchy lines

■■ DWG/DXF import/export

■■ PDF, EPS, 3DS, IFC, FBX, OBJ, XSI, VRML export

■■ BIM classifier

■■ IFC import/export

■■ Component-based report-generation

■■ Dynamic Component authoring

■■ Solid Tools for Boolean modeling

Many of these features allow the professional SketchUp user to integrate it into their work-
flow by making it easier to exchange data with CAD software (such as Autodesk AutoCAD), 
BIM software (like Autodesk Revit), online collaboration platforms (like Trimble Connect), 
and presentation software (e.g., Adobe Illustrator). Modeling and workflow enhancements 
(such as the ability to create Dynamic Components) also provide the professional user with 
the capability to create and disseminate product-model databases that facilitate planning 
and estimating tasks.

LayOut, which comes with SketchUp Pro, has the ability to replace other drawing- and 
presentation-creation software, enabling you to keep that aspect of your workflow tightly 
aligned with SketchUp. 3D models created in SketchUp are always live-linked in LayOut so 
that updates propagate through the entire drawing set.

While the free Make version just requires a download, at the time of writing, the Pro ver-
sion was priced at $590 (in the United States), which includes one year of upgrades and costs 
$95 per year thereafter. Both versions are currently available in a multitude of languages, 
which gives this software global reach. At this point, qualified students can get a time-limited 



Architectural Design with SketchUp

10

license to use SketchUp Pro for $49 (also U.S. pricing). You can find out more about these 
purchase options on their website: www.sketchup.com.

Depending on your needs, you have to decide which version is right for you. If you use 
SketchUp only for noncommercial projects or for training and you have no need for any of 
the aforementioned Pro features, then the Make version should suffice—the majority of this 
book’s content, such as photorealistic rendering, many extensions, and scripting, will work 
well with it. This book then offers a cost-efficient entry into relevant and current topics 
(such as 3D modeling, rendering, and computational geometry). If you, however, need the 
more advanced features and are planning on using SketchUp professionally, then your best 
approach is to get the Pro version right away.

This book was written to be applicable to both versions. However, when tools are dis-
cussed that are available only in the Pro version (e.g., creating a Dynamic Component or using 
Solid Tools), they are visually presented as a “Pro Only” section.

www.sketchup.com—The official home of SketchUp. You can get the latest Make or Pro 
version here.

http://blog.sketchup.com—The official SketchUp blog—a great source for updates, 
tutorials, and tips.

http://help.sketchup.com—SketchUp’s knowledge center. If you get stuck, go here first!

http://forums.sketchup.com—SketchUp’s user forums. Another great place to discuss 
problems and get help.

www.alexschreyer.net—My personal blog where I frequently post about SketchUp and 
other AEC software.

@alexschreyer—My Twitter handle under which I post news and links about SketchUp 
and AEC software.

Pro Only sections look like this.Pro Only

While all of this book’s illustrations have been created using the Windows version of 
SketchUp, the tasks and tutorials are similarly usable with the Mac version. Menus and 
dialogs generally look the same and are in the same location on both platforms. There are 
minor user-interface differences, but they are easy to figure out. Consult SketchUp’s help 
system if you run into trouble.

It is also a good idea to stay up to date with SketchUp. In addition to this book’s com-
panion website, bookmark the following sites to help you with this:

http://www.sketchup.com
http://www.sketchup.com
http://blog.sketchup.com
http://help.sketchup.com
http://forums.sketchup.com
http://www.alexschreyer.net
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How This Book Works
One way to use this book is linearly as a learning tool by moving from chapter to chapter. 
This method builds your skill set gradually and allows you to logically approach each subject.

You may also want to use it as a desk reference, or you might be interested only in indi-
vidual chapters. In these cases, make use of the index and the appendices.

Some conventions in this book:

■■ Whenever I mention a window (e.g., the Materials window), this means the dialog win-
dow that can be accessed from SketchUp’s Window menu.

■■ Other dialogs that open when the user clicks on something are commonly called dialogs 
in the text.

■■ Menu locations are typically presented in this format: File → Open….

■■ Whenever a tool from the context menu is mentioned, remember that you need to 
position the mouse cursor above something to get the menu options that relate to this 
object’s context when you right-click.

■■ Any toolbars mentioned in the text can be opened from the View → Toolbars menu 
in SketchUp (or by right-clicking on any open toolbar). Extensions often install their own 
toolbars. They will, of course, not be available until a plugin has been installed.

■■ Many examples in this book use US-customary construction units such as the inch (”) or 
foot (’). If you don’t use these units, read the “Setting Units and Fonts” section in Chapter 
2 and adjust the use of units in the examples to your unit system. SketchUp works well 
with any unit system.

■■ Following are some Mac-specific differences:

■■ SketchUp’s preferences cannot be found under the Window menu item, but instead 
are under the SketchUp menu.

■■ Toolbars are called tool palettes.

■■ Instead of right-clicking to bring up the context menu, you can left-click the mouse 
while holding the Control key.
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Let’s Go!
It’s time to explore the world in the third dimension. Enjoy your modeling endeavors!
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Chapter 2
A SketchUp Refresher 

This chapter reviews some of SketchUp’s basic techniques. You’ll also learn about customizing 
the software environment and adjusting settings to help you with your daily tasks.

Key Topics:

■■ Where to get help with SketchUp

■■ Program interface and workspace customization

■■ Program and model preferences

■■ Working with templates

■■ Navigating SketchUp’s 3D workspace

■■ Aids for accurate modeling

■■ Groups and components

■■ Applying materials and using other common tools

■■ Modeling from images

■■ Geo-based modeling

■■ Best practices for working with SketchUp

Let’s Get Started!
Before we look at any of the more advanced SketchUp techniques such as extensions, ren-
dering, and scripting, it would be helpful for any user to review some of the basic modeling 
techniques. This chapter presents in a condensed fashion an overview of the interface and 
the modeling and editing tools, as well as best practices and usability hints.

If you have no prior experience with SketchUp or would like to learn more about any of 
the basic topics, then my best recommendation is to get a copy of Aidan Chopra’s excellent 
SketchUp primer SketchUp 2014 for Dummies (Wiley Publishing). It is a cost-efficient and 
thorough reference not only for modeling with SketchUp but also for presenting your models.

Two further sources for help are built right into SketchUp. One is the official help 
documentation. You can access it through the Help menu item, which simply opens a 
browser window at the following URL (if you end up using it frequently, it might be a good 
idea to bookmark it in your browser):

http://help.sketchup.com—SketchUp’s online help system.

http://help.sketchup.com
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Alternatively, you can turn on the Instructor feature by selecting Instructor from the 
Window menu. This opens (and keeps open) a window that displays help for the tool that is 
currently in use. For example, if you start using the Circle tool (by clicking the Circle toolbar 
button, selecting Circle in the Draw menu, or simply pressing the C key on the keyboard), 
the Instructor shows the appropriate help, complete with a small animation. (See Figure 2.1)

Figure 2.1:  SketchUp’s Instructor window

I also encourage you to visit this book’s companion website www.sketchupfordesign.com for 
additional tutorials, forums, videos, and an updated list of links to online resources. In addi-
tion, many discussion forums, wikis, and online video sites are available that offer help for 
both beginners and advanced users. The most popular ones include:

www.sketchup.com/learn—SketchUp’s own tutorials and training videos.

www.youtube.com/user/SketchUpVideo—SketchUp’s YouTube channel.

http://forums.sketchup.com—SketchUp’s official help forum.

http://sketchucation.com/forums—The SketchUcation forums, a user-based worldwide 
community.

www.mastersketchup.com—Matt Donley’s tutorial site.

www.aidanchopra.com—Aidan’s companion site to his book, which contains many 
YouTube instructional videos.

www.sketchupschool.com/sketchup-tutorials—A large collection of SketchUp video 
tutorials (subscription-based).

http://danieltal.com—Daniel Tal’s SketchUp tutorials (subscription-based).

http://www.sketchupfordesign.com
http://www.sketchup.com/learn
http://www.youtube.com/user/SketchUpVideo
http://forums.sketchup.com
http://sketchucation.com/forums
http://www.mastersketchup.com
http://www.aidanchopra.com
http://www.sketchupschool.com/sketchup-tutorials
http://danieltal.com
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Interface and Program Setup
Once installed, SketchUp has a clean and rather empty appearance. The main portion of the 
screen is taken up by a large 3D-space work area in which only the ground plane or back-
ground (shown in green or gray), sky (blue gradient), the three main axes, and a modeled 
2D person (included as a size reference) are visible.

The person in SketchUp’s default template has historically been either an employee from 
the SketchUp team or someone close to them. For version 2015, this person is Steve. Earlier 
versions featured Sophie, Derek, Susan, Sang, and Brad.

Tip

Above the work area, the main toolbar buttons are nicely arranged on a toolbar  
called Getting Started. Figure 2.2 shows the initial workspace on Windows; Figure 2.3 
shows the Mac equivalent. Both use the Architectural Design template that ships with 
SketchUp.

Figure 2.2:  SketchUp’s workspace on Windows

SketchUp’s numerous features can be accessed either through the screen menu, by click-
ing a button on the toolbars, or with keyboard shortcuts. As with many other programs, any 
toolbars that are not currently activated and visible can be displayed by selecting them in the 
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Figure 2.3:  SketchUp’s workspace on the Mac

Toolbars dialog. Open it either by going to the View → Toolbars… menu or by right-clicking 
on any toolbar area and selecting Toolbars… from the context menu. This right-click menu 
also lets you directly turn toolbars on or off.

If you frequently need to access a certain set of tools (even those provided by extensions), 
you can create a custom toolbar in the Toolbars dialog and arrange those tools on it.

Tip

Figure 2.4 shows a modified toolbar setup where the very useful Large Tool Set toolbar 
has been activated and placed on the left side of the screen (in addition to the Standard, 
Styles, and Views toolbars on the top). It is always a good idea to have at least this one 
opened—even if no others are needed. In addition to the features in the standard Getting 
Started toolbar, Large Tool Set gives direct access to more navigation tools. However, it does 
not contain any of the 3D Warehouse, Extension Warehouse, or Google Earth buttons. If 
you need those, make sure you activate the Warehouse or Google toolbars, respectively.

It is a good idea to develop a well-organized workspace in any software. In SketchUp, 
this means that if you find yourself using the same tools over and over (and you can’t access 
them using keyboard shortcuts, or you prefer toolbars), then you might want to display the 
appropriate toolbar and dock it on the screen in a convenient position.

A very useful feature of SketchUp’s user interface is keyboard shortcuts. Even with the 
default settings, many tools can be accessed by pressing single keys. For example, the L key 
brings up the Line tool, R the Rectangle tool, and the spacebar the Select tool (and cancels any 
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Figure 2.4:  Working with SketchUp’s tools

other currently active tool). An overview of the default keyboard shortcuts (and most tools) 
is given in Appendix A. As you can see in Figure 2.5, you can, in addition, assign keyboard 
shortcuts to any tool that is available in the menu structure. Just remember to export your 
keyboard settings (from within the Preferences dialog) so that you have a backup available 
in case you need to reinstall SketchUp.

Figure 2.5:  Keyboard shortcut preferences
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Although not absolutely necessary at this point, it might be a good idea to already 
be logged in with your Google account. Look for the person icon at the bottom of your 
SketchUp screen. This will be necessary later when you interact with the 3D Warehouse and 
the Extension Warehouse. Always being logged in has the benefit that SketchUp will tell you 
when any updates become available for installed extensions.

You can even assign a keyboard shortcut to plugin-supplied tools (as long as those tools 
have created their own menu items).

Tip

Adjusting SketchUp’s Preferences
It is a good idea to spend some time tweaking all the options in SketchUp’s Preferences to your 
liking, especially if you are a frequent user (access the dialog under Window → Preferences). 
The following is a list of the main options, along with some tips:

■■ Applications—Select the path to your default image editor here (e.g., Adobe Photoshop). 
This makes it possible, for example, to tweak textures using that editor by opening images 
in the external editor directly from within SketchUp.

■■ Compatibility—You can change your highlighting and mouse wheel preferences here.

■■ Drawing—You can select your click preferences here. For example, you have the choice 
of whether you want to draw a line by clicking and dragging or by clicking two points. 
Another useful feature is Display Crosshairs, which always gives you an axis reference 
when you have a tool activated.


